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June 12, 2020

How To Use WordPress Menus
wptrainingmanual.com/wordpress-tutorials/menus

In this tutorial, you will learn how to create, edit, and use custom navigation menus in
WordPress.

This tutorial covers the following sections:

Overview of WordPress Menu Editor

WordPress provides a powerful and flexible built-in menu editor that lets you:

https://wptrainingmanual.com/wordpress-tutorials/menus/
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Create multiple custom menus (as many as you like).
Add different link types to each menu (e.g. pages, posts, product pages, categories,
tags, external URLs, etc.
Rearrange the order of your menu items using drag and drop or clicking ordering links.
Organize menu items into hierarchical lists with submenus nested many levels deep.
Automatically add links to menus when you add new pages, posts, etc. to your site.
Place your custom navigation menus anywhere you like on your site (e.g. sidebar,
header, footer, etc.) using blocks and widgets.

Notes:

Where and how you place menus on your site depends on your active WordPress
theme and whether you are using the WordPress Block Editor or WordPress
Classic Editor.
Make sure that you already have added pages, posts, categories, etc. to your site
before creating menus.

To access and manage your menus, log into your WordPress administration area and go to
Appearance > Menus.

From the main WordPress menu, select Appearance – Menus.

This brings up the Menus screen.

https://wptrainingmanual.com/wordpress-tutorials/gutenberg-blocks/
https://wptrainingmanual.com/wordpress-tutorials/widgets/
https://wptrainingmanual.com/wordpress-tutorials/themes/
https://wptrainingmanual.com/wordpress-tutorials/block-editor/
https://wptrainingmanual.com/wordpress-tutorials/wordpress-classic-editor/
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The WordPress Menus screen.

You can also access the Menus screen from your theme management area by going to
Appearance > Themes, selecting your currently active theme, and clicking on the Menus
button.

Select your theme and click on the Menus button to go to the Menus screen.
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Creating A Menu

The Menus screen is where you can create multiple menus, customize these with different
link types, and add custom navigation menus to different areas of your site.

If no menus have been created yet, the Menus screen will display a blank menu template
with a single tab called ‘Edit Menus’ and a prompt to create your first menu.

No menus created yet!

To create a new menu, give your menu a name (in the Edit Menus tab > Menu structure
section > Menu Name field) and click on the Create Menu button.
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Give your new menu a name and click on the Create Menu button.

You can also create a new menu by clicking on the ‘create a new menu’ link below the
Menus screen tab as shown below.
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Click on the link to create a new menu.

Once the first menu has been created, the Menus screen displays the following tabs:

Edit Menus
Manage Locations

Edit Menus and Manage Locations tabs.

Let’s go through each of these tabs.
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WordPress Menus – Edit Menus

Navigating the Edit Menus tab

The Edit Menus tab includes the following sections:

1. ‘Select a menu to edit’ drop-down menu or create a new menu.
2. Add menu items
3. Menu structure
4. Menu Settings
5. Delete menu link
6. Save/Update Menu button

The Edit Menus tab.

Once you have created a new menu, you can edit it by going to the Edit Menus tab, selecting
the menu from the Select a menu to edit drop-down menu, and clicking the Select button.
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Choose a menu from the dropdown and click the Select button to edit it.

To avoid cluttering your screen, the Menu items and elements on this screen are collapsible.

Click on the little black triangle to expand or collapse items.

Click on the little black triangles to expand and collapse menu items.
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Additionally, many items in the WordPress Menu editor include internal features and options
like tabs, search and navigation links, and various fields, some of which you can choose to
display or hide on your screen.

WordPress Menu editor features.

Now that you understand how to navigate the Edit Menus tab, the next step is to add links
(e.g. pages, posts, etc.) to your menu.

Adding Menu Items

Some common menu items you can add to your menu(s) include:

Pages
Posts
Custom Links
Categories
Tags
FAQs
etc.
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Add menu items.

Depending on the theme and plugins installed on your site, you may find additional menu
items in this column.

https://wptrainingmanual.com/wordpress-tutorials/themes/
https://wptrainingmanual.com/wordpress-tutorials/plugins/
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You can expand available menu items by installing certain plugins on your site.

In the screenshot below, you can see that there are no menu items listed in the Menu
Structure section.
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No menu items added yet.

To add links to pages, posts, etc. to your menu, select link types from the list of menu items
on the left column of your screen by ticking their checkboxes, and click the Add to Menu
button.
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Select menu items and click the Add to Menu button to add items to your custom menu.

The item(s) will be added to the Menu Structure section.
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Add menu items to the Menu structure section to build your custom menu.

Repeat this process to continue adding new items to the Menu structure section.

You can add items from each of the different link types shown in the Add menu items
column.
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Add different link types to your custom menu.

After adding new item(s) to your menu, remember to click on the Save Menu button to save
and update your menu settings.
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Click the Save Menu button to update your menu settings.

If you don’t save your changes, a window will pop up asking you to confirm if you want to
leave the page and lose your changes. Click Cancel to stay on the page.

Remember to save your changes before exiting the Menus screen.

Show/Hide Menu Fields

Some menu elements will NOT display in the Edit Menus section unless you add specific
plugins or functions to your site that support custom menu features.

Other elements, however, are initially hidden by default.

For example, you can add links to posts, and even tag pages to your menus. If you don’t see
these listed on your menu screen, do the following to display these:
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Scroll to the top right-hand corner of your Edit Menus screen and click on the Screen
Options tab.

Click the Screen Options tab to view additional Menu Screen options.

In the Screen elements section, tick the checkboxes next to any elements that you would
like to display.

Show or hide screen elements by enabling or disabling checkboxes.

The item will now appear on the Add menu items section.

https://wptrainingmanual.com/wordpress-tutorials/screen-options/
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Display menu items like tags on your Menus screen by enabling the option in the Screen Options tab.

In the Add menu items section of certain link types (e.g. Pages and Posts), you can choose
to view only your most recent items, view all items, or search for specific items (just type a
word into the search field and WordPress will automatically search and return matching
results).
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Use the Search tab to quickly find menu items like Posts and Pages.

With other link types (e.g. categories and tags), you will see slightly different options (e.g.
Most Used).
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Menu item panels like categories and tags display Most Used tabs.

Some items have no additional inline options (e.g. Custom Links).
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Custom links panel.

To add multiple items to your menu structure select multiple checkboxes and click on the
Add to Menu button.
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Select and add multiple items to your menu.

Or, add all the items in a list by clicking the Select All link then the Add to Menu button.
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Tick the Select All checkbox to select and add all menu items to your menu.

You can also add links to external URLs to your menu, using the Custom Links panel.
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Add links to external URLs to your menus using the Custom Links panel.

You can easily identify custom links in your menu structure, as the menu will display a
Custom Link tag.

Custom link menu item.
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Note too that if you’re using a single editor only (e.g. the Block editor), menus simply display
their link type (e.g. Post or Page).

The WordPress menu editor lets you quickly see which links on your menus are Posts or Pages.

If, however, you are using both the WordPress classic editor and the block editor to create
posts and pages, WordPress will tag these in the menu item descriptors.
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The menu editor also lets you view menu items created using the WordPress block or classic editors.

Editing Menu Items

After adding items to your menu, you can further modify and customize these.

Expand Or Collapse Menu Items

As mentioned earlier, you can expand or collapse a menu item by clicking on the little
triangle on the right-hand corner of the title bar.
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Click the triangle icon to view additional settings for your menu items.

Open Navigation Menu Links In A New Browser Tab

Opening navigation menu links in a new browser tab means allows visitors to stay on the
page after closing the tab.

By default, WordPress hides the option to open navigation menu links in a new tab to
prevent cluttering up your menu item panel.

If you want a menu item to open on a new tab when visitors click on the menu link, do the
following:

First, expand the menu item.
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Expanded menu item.

If you can’t see the Open link in a new tab field below the Navigation Label field, open the
Screen Options tab and make sure that the Link Target checkbox is selected in the Show
advanced menu properties section.

Enable the Show advanced menu properties – Link Target checkbox in the Screen Options tab.
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You should now see the Open link in a new tab option. Tick this checkbox to open the link
in a new tab when visitors click on the menu link.

Enable the checkbox to open the menu link in a new tab.

Remember to save your changes when done to update your menu settings.

Advanced Menu Properties

Advanced menu properties are mostly used by web developers and WordPress theme
designers to further enhance, style, and customize menu options.

Your theme must support advanced menu properties for these options to work.

The screenshot below shows an item with all the advanced options displayed (you can
enable these options in the Screen Options tab):
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1. Title Attribute
2. CSS Classes (optional)
3. Link Relationship (XFN)
4. Description

Advanced menu properties.

Let’s take a brief look at each of these properties.

Title Attribute: This field specifies the Alternative (‘Alt’) text for the menu item. This text
displays when a visitor hovers over a menu item.

For example, if you add the following line into the Title Attribute field and then save your
menu…
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Let’s add a title attribute to this menu item.

Here is what your visitors will see if they hover over the menu link…

The title attribute displays like a tooltip when visitors hover over menu items.

CSS Classes: This allows you to style your links using CSS (Cascading Style Sheets). After
adding a CSS class to a menu link, you can then target the classes you have assigned from
within your stylesheet. Note: This requires knowledge of CSS.

https://wpmasterclasses.com/video-courses/how-to-use-css/
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Link relationship (XFN): XFN (XHTML Friends Network) is a simple way to represent the
relationships you share with the owners or authors of other websites using links.

This allows certain programs such as search engines and specialized services to understand
and display the relationships you share with other people, such as friends, professional
contacts, etc.

For more information, go here: XFN

Description: This field can be used to add a short description to a menu label.

Adding short menu descriptions can help users understand your menu items better.

You can also give your menu label a custom name that is different from the name of your
original page name.

http://codex.wordpress.org/Defining_Relationships_with_XFN
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Customize the label of your menu items.

Reordering Menus

The WordPress menu editor lets you easily reorder items on your menus.

To rearrange menu items, first, make sure you have added some items to your menu.

Make sure to add some items to your menus.
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After adding menu items, notice that “Move” options will display in your item’s details section,
allowing you to move the position of your item on the menu bar relative to other menu items
(e.g. move up, move down, move to the top, nest under the item shown above, etc.).

Click on the links to reposition items on your menus.

To rearrange your menu items, you can either click on a “Move” option or click the title bar of
an item, hold, then drag and drop it into another position.
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Clicking on the Move links or use drag and drop to reorder your menu items

You can use a combination of both methods to get your menu items ordered exactly how you
would like them to display.
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Reorder menu items quickly using Move links and drag and drop.

How you order menu items in the menu editor is how your visitors will see them.

For example, here is a screenshot of a menu placed below the theme header, with items
displayed in a certain order…
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Let’s reorder these menu links…

If we now rearrange the order of menu items to look like this…

Drag and drop items to reorder this menu.

The reordered menu links will automatically display to visitors as you have arranged them in
the menu editor.
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Reordered menu links.

You can also create nested menus using drag-and-drop by shifting their position away from
the left margin.

You can nest menu items multiple levels deep.

Nest menu items using drag and drop.
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Here is an example of the resulting nested menu configuration created in the previous
screenshot.

WordPress lets you create deeply nested menus.

Note: menu styles are controlled by the styling options in your theme and will display
differently depending on the WordPress theme installed on your site.

Here are some examples of using different themes with the same menu:

Example #1…

WordPress Theme – Twenty Thirteen.

Example #2…

https://wordpress.org/themes/twentythirteen/
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WordPress Theme – Twenty Twenty-One.

Example #3…

WordPress Theme – Avril.

Example #4…

https://wordpress.org/themes/twentytwentyone/
https://wordpress.org/themes/avril/
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WordPress Theme – Zubin Music.

If you need help finding themes for your site, see this tutorial: Where To Find WordPress
Themes

Menu Settings

The Menu Settings section lets you automatically add pages to menus depending on the
options you choose:

Auto Add Pages: Automatically add new top-level pages to this menu. When you
check this box, every new page you create on your site will be automatically added to
the selected menu. Note: Use this option with caution because your menu will change if
you use this feature.
Display location: Enable or disable the locations where you would like the selected
menu to appear on your site. Options displayed in this section depend on your currently
active theme.

https://wordpress.org/themes/zubin-music/
https://wptrainingmanual.com/wordpress-tutorials/find-themes/
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Configure menu settings in the Edit Menus section.

Most WordPress themes support custom menus.

If your current theme supports custom menus, you will be able to add your new menu
to one of the Display locations.
If your current theme does not support custom menus, you will need to add your new
menu via the Custom Menu widget.

Manage Locations

For menus to display on your site, you will need to assign your menus to a location on your
theme (e.g. header, footer, sidebar, etc.).

Some WordPress themes provide only one menu location, even if you have created multiple
custom menus.

https://wptrainingmanual.com/wordpress-tutorials/use-widgets-3/
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This theme supports only one menu location.

This theme supports two menu locations…

This theme supports two menus.

And this one has three menu locations…
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This theme supports three menus.

Some themes support multiple menu locations, and some themes support only one menu. It
all depends on your theme.

To assign an existing menu to a location on your theme, choose one of the menus you have
created from the dropdown menus in the Assigned Menu column.
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Select a menu for each of your theme’s Assigned Menu locations.

If your theme supports multiple menus, repeat the above process to assign menus to all
menu locations.

Click on the Save Changes button when done to save your menu configuration.
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Save your changes.

Your menu locations will now be updated.

Your menu locations are now updated.

Make sure to visit your site to check that the custom menu you have created is displaying
correctly in the assigned location of your theme.
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Check your menu to make sure everything is working as you intended.

Remove Menu Items

To remove an item from your menu, expand the item and click on the Remove link.

Click the Remove link to remove an item from a custom menu.
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You can also delete multiple items from your menu.

Click the Remove link to remove items from your menu.

Delete Menus

To delete the menu itself, load the menu in the Edit Menus screen. Make sure that you have
selected the right menu (especially if you have multiple menus), then scroll down to the
bottom of the page and click on the Delete Menu link.
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Click the Delete Menu link to delete the selected menu from your site.

You will be asked to confirm the deletion. Click OK to proceed or Cancel to escape.

Click OK to permanently delete the menu or Cancel to abort.

The selected menu will be deleted.

Your menu has been successfully deleted.
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Manage With Live Preview

Use the Manage with Live Preview feature to view any changes made to your menus
before permanently saving these.

Click the Manage with Live Preview button to view your changes without saving and making them live.

This will bring up the Theme Customizer screen and Live Preview feature.

Preview your menu changes in the Theme Customizer screen.

If you need help using this feature, see this tutorial: How To Use The WordPress Theme
Customizer

Using Custom Menus With Widgets

Custom menus can be added to your sidebar and other menu locations using widgets.

To learn how to add menus to your site using widgets, see this tutorial: How To Use Widgets
– Part 3

Additional Information

There are many plugins you can use to enhance your WordPress menus.

https://wptrainingmanual.com/wordpress-tutorials/theme-customizer/
https://wptrainingmanual.com/wordpress-tutorials/theme-customizer/
https://wptrainingmanual.com/wordpress-tutorials/use-widgets-3/
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You can search for WordPress menu plugins inside your WordPress dashboard (Plugins >
Add New), or the WordPress Free Plugin Directory.

Search the WordPress directory for thousands of menu-enhancing plugins.

Congratulations! Now you know how to create and use custom navigation menus in
WordPress.

Add custom navigation menus to your WordPress site.
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